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Введение 

В настоящее время вычислительная гидрогазодинамика 

(Computational Fluid Dynamics – CFD) становится всѐ более 

популярным инженерным инструментом. Это обусловлено такими еѐ 

качествами, как формальная простота постановки задачи и 

независимость методики еѐ решения от рабочего процесса 

исследуемого узла. То есть, освоив методику решения простых задач, 

инженер может переходить к более сложным, реалистичным задачам, 

повысив квалификацию только в области нового способа задания 

граничных условий или параметров счѐта. В данном методическом 

указании приведены рекомендации для практического освоения CFD 

пакета Ansys Fluent на примере расчѐта Г-образного тройника. 

Процесс любого CFD-расчѐта состоит из пяти основных 

этапов: 

1. Создание геометрической модели (CAD-модели) исследуемого 

узла. Для расчѐта необходимо сформировать компьютерную 

геометрическую модель интересующей области течения. Ansys 

Fluent позволяет производить решение как в двумерной, так и 

трѐхмерной постановках. 

2. Создание сеточной модели расчѐтной зоны на базе 

геометрической. Иными словами, это разбиение твѐрдотельной 

модели, созданной в предыдущем пункте, на отдельные малые 

ячейки. Эта процедура производится полуавтоматически в 

специальных системах – сеткогенераторах. 

3. Создание расчѐтной модели из сеточной путѐм наложения 

расчѐтных условий. В первую очередь, задаѐтся набор уравнений, 

которые требуется решать. Для задач теплопроводности – это 

всего одно уравнение сохранения тепловой энергии, для потоков 
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жидкости – уравнение неразрывности и моментов количества 

движения по двум или трѐм осям. Если в расчѐте используется 

моделирование турбулентных явлений, к общему набору 

уравнений добавляются ещѐ уравнения турбулентной модели и 

т.д. После определения набора решаемых уравнений указываются 

«входные данные» для решения системы уравнений – это условия 

тех элементах, характеристики потоков в которых известны. 

Например, в задаче определения тепловых потоков в твѐрдой 

пластине, входными данными являются значения температур на 

соответствующих гранях крайних ячеек. Эти условия называются 

граничными. Кроме граничных условий требуется ещѐ и задание 

начальных параметров в каждой ячейке внутри расчѐтной области. 

Это так называемые начальные условия. 

4. Поиск решения. На данном этапе производится отыскание таких 

значений параметров в каждой расчѐтной ячейке, чтобы вся 

расчѐтная зона имела максимально верные уравнения потоков. В 

начальный момент решения эти уравнения скорее всего, не 

выполняются, потому что начальные условия задаются с большой 

погрешностью. Методами численного решения уравнений, 

система находит параметры, при которых все уравнения 

выполняются. Такое решение называется сошедшимся. 

5. Представление результатов расчѐта. «Сырым» результатом 

расчѐта является сетка, в которой найдены параметры (давление, 

температура, скорость, плотность), соответствующие 

сошедшемуся решению. Для удобства восприятия результаты 

анализа представляют в виде графиков, цветных или векторных 

полей распределения параметров, линий тока, изоповерхностей 

параметров, числовых значений параметров в заданных областях. 

 

Далее описаны все этапы решения задачи на примере течения 

воды в Г-образном смесителе. 
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Создание геометрической модели 

Ansys Fluent может функционировать как отдельно (Standalone), так и 

под управлением системы интеграции Ansys WorkBench. При запуске 

из-под WorkBench может осуществляться автоматическая интеграция 

системы трѐхмерного моделирования, сеткогенератора и расчѐтных 

систем, что позволяет производить вариантное проектирование. 

Запуск Ansys WorkBench осуществляется из главного меню: 

Пуск -> Программы -> Ansys 13.0 -> . 

 

Окно программы (рис. 1) состоит из рабочего поля проекта, 

списка компонентов, окна сообщений и ещѐ нескольких элементов, 

которые могут быть включены опционально (список файлов, окно 

статуса проекта и т.п.). 

 
Рис. 1 - Вид окна программы Ansys WorkBench 
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Чтобы добавить CAE-анализ в Fluent в новый проект, найдите 

в списке систем анализа Fluid Flow (Fluent) [Toolbox->Analysis 

Systems-> Fluid Flow (Fluent)] и совершите одно из действий: 

1. «ухватите» компонент (нажав и удерживая левую кнопку 

мыши) и перетащите его на свободное поле проекта к любому месту, 

где появится зелѐный пунктирный прямоугольник, разрешающий 

размещение, и «бросьте» его там (отпустите кнопку мыши) (рис. 2); 

2. дважды щелкните по компоненту левой кнопкой мыши. При 

этом он будет автоматически перенесѐн на первое свободное место 

проекта. 

 

   
Рис. 2 - Перенос системы анализа потоков Fluent на поле проекта 

 

На поле проекта появится таблица Fluid Flow (Fluent), в 

нижней части которой предлагается ввести название. Чтобы оставить 

название по умолчанию достаточно нажать Enter или кликнуть 

мышью на свободное поле проекта. 

Рассмотрим подробнее таблицу добавленной системы анализа. Она 

состоит из шести строк. В первой на синем поле указан тип системы 

(Fluid Flow (Fluent)). Далее идут пять строк с названиями Geometry 

(геометрическая модель), Mesh (сетка), Setup (постановка задачи), 

Solution (решение), Results (анализ результатов). В правой части 

каждой строки имеется пиктограмма, обозначающая еѐ статус, синий 

знак вопроса показывает, что данный пункт пока не определен (ничего 

не задано). Каждому элементу соответствует его обрабатывающее 

приложение. Так, геометрическую модель (Geometry) обрабатывает 

встроенная в WorkBench система трѐхмерного моделирования Design 

Modeler, сетку (Mesh) - сеткогенератор (Mesher) и т.д. Чтобы 

вызваться то или иное приложение, достаточно дважды щелкнуть 
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левой кнопкой мыши на интересующем пункте. Также можно 

щелкнуть правой кнопкой мыши, например, на пункте Geometry 

(геометрическая модель) и в появившемся контекстном меню (рис. 3) 

выбрать пункт New Geometry (новая геометрия) или Edit (изменить).  

Открывшееся окно системы трѐхмерного моделирования 

Design Modeler при первом запуске предлагает выбрать единицу 

измерения будущей модели (рис. 4). Нужно выбрать Inch (дюймы) и 

нажать OK.  

 
Рис. 3 - Создание новой 

геометрической модели 

 
 

Рис. 4 - Выбор единиц измерения 

будущей модели 

 

Основную часть окна системы трѐхмерного моделирования 

Design Modeler (рис. 5) занимает графическое окно с градиентной 

заливкой (Graphics), слева от которого расположено дерево проекта 

(Tree Outline) и окно детализации (Details View). Также имеются 

главное меню и панели быстрого, на которых расположены кнопки 

вызова часто используемых команд. Все панели можно перемещать, 

ухватив мышью, для создания удобного пользователю пространства. 

Однако, при этом легко «потерять» панель под другими. Для 

восстановления первоначального вида окна программы в главном 

меню есть пункт сброса параметров панелей: 

 

View -> Windows -> Reset Layout 
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Рис. 5 - Окно Design Modeler 

 

Далее необходимо создать модель патрубка, представленного 

на рис. 6. Далее описаны действия по шагам. 

 
Рис. 6 - Модель Г-образного тройника 

Шаг 1. Создаѐм модель четверти тора: 

Create->Primitives->  
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В окне детализации нужно ввести необходимые данные: 

Base Definition: 

 - Angle  90°; 

 - Inner Radius 4 in; 

 - Outer Radius 8 in. 

И нажать кнопку . При этом будет создана 

твѐрдотельная модель четверти тора (рис. 7). В дереве проекта 

появится пункт 1 Part, 1 Body, показывающий, что в данный момент 

проект содержит одну деталь и она является телом (не поверхностью). 

 

 
Рис. 7 - Окно Design Modeler с четвертью тора 

 

Шаг 2. Создаѐм новую плоскость на торце тора, обращенном вдоль 

оси X. Для этого вызываем меню создания плоскости: 

Create ->  
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В появившемся окне детализации (рис. 8) задаѐм тип новой 

плоскости Plane 4 «от поверхности» (Type -> Form Face). Далее в 

появившейся в таблице жѐлтой строчке Base Face (базовая 

поверхность) нужно указать ту поверхность, от которой будет 

построена плоскость. Для этого нужно левой кнопкой мыши щѐлкнуть 

один раз по элементу таблицы Not Selected (не выбрано). При этом 

система перейдѐт в режим выбора: появляются кнопки Apply 

(применить) и Cancel (отменить). Система будет находиться в режиме 

выбора, пока не будет нажата одна из этих кнопок. Т.е. нужно указать 

требуемую поверхность торца, щелкнув по ней левой кнопкой мыши 

(она станет зелѐной), а затем нажать кнопку Apply, подтвердив выбор 

(она станет голубой, а в строка Base Face примет значение Selected 

(выбрано)). Завершить создание плоскости нужно нажатием кнопки 

. При этом в дереве проекта у элемента Plane 4 появится 

зелѐная галочка ( ), означающая завершенность объекта. 

 

 

  
 

Рис. 8 - Окно Design Modeler при задании новой плоскости 
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Шаг 3. Создаѐм цилиндрическую часть трубы. Для этого используем 

операцию вытягивания ( ) на панели быстрого доступа или 

через главное меню: 

Create ->  

 

Поскольку операции Extrude предшествовала операция 

создания плоскости, интеллектуальная система автоматически возьмѐт 

в качестве вытягиваемого объекта недавно использованный торец 

тора, а в качестве направления вытягивания - нормаль плоскости. При 

этом труба будет отрисована в каркасном виде (рис. 9). Для 

завершения операции необходимо задать глубину вытягивания (Depth) 

- 4 дюйма (4 in) и нажать кнопку . 

  
Рис. 9 - Выполнение операции Extrude 

 

При этом цилиндрическая часть трубы автоматически 

объединится с прежним телом в одну деталь (1 Part), поскольку в 

качестве операции (Operation) по умолчанию стояла опция Add 

Material (добавить материал). 

 

Шаг 4. Создаем на втором торце тора новую плоскость Plane5: 

Create ->  

В окне детализации: 

Type -> Form Face 

Base Face -> <щелкнуть по элементу Not Selected> -> 

<Выбрать нужную торцевую поверхность> -> <нажать Apply> -> 

Selected (рис. 10). 
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Завершить создание плоскости нажатием кнопки . 

  
Рис. 10 - Окно Design Modeler при задании новой плоскости 

 

Шаг 5. Создаем на втором торце цилиндрическую часть трубы 

операцией вытягивания: 

Create ->  

В окне детализации задать глубину вытягивания 8 дюймов: 

Depth -> 8 in 

и нажать  (рис. 11). 

 

  
Рис. 11 - Созданный Г-образный патрубок 
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Шаг 6. Создаем третий патрубок диаметром 0,8 дюйма. Для этого в 

проект нужно добавить цилиндр: 

Create -> Primitives ->  

В окне детализации нужно указать базовую плоскость (Base 

Plane) цилиндра - Plane 5. Для этого нужно щѐлкнуть левой кнопкой 

мыши по строке Base Plane, чтобы появились кнопки Apply/Cancel, 

затем выбрать в дереве проекта элемент Plane 5 и нажать Apply. Затем 

нужно длину и радиус цилиндра (рис. 12): 

Axiz Z Component -8 in 

Radius   0,8 in 

«Минус» означает, что цилинд будет вытянут в отрицательном 

направлении оси. Также обратите внимание, что разделителем целой и 

дробной части чисел является запятая, а не точка. После задания всех 

параметров и визуальной проверки правильности формы цилиндра, 

нужно завершить построение, нажав . 

   
Рис. 12 - Создание малого патрубка  

 

Шаг 7. Отделение половины модели плоскостью симметрии. 

При CFD-расчѐтах симметричных процессов можно применять 

расчѐт части устройства с последующим соединением частей. Данный 

патрубок можно рассчитывать в симметричной постановке, для этого 

нужно отделить его половину специальным инструментом - 

плоскостью симметрии: 

Tools -> Symmetry 
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В окне детализации нужно указать первую плоскость 

симметрии (Symmetry Plane 1), выбрав в дереве проекта плоскость XY, 

затем подтвердить выбор, нажав Apply, а затем закончить построение 

плоскости симметрии, нажав  (рис. 13). 

 

 
Рис. 13 - Создание плоскости симметрии и окончательная модель 

 

После окончания построения модели можно закрыть Design 

Modeler и вернуться в WorkBench. При этом сохранение модели будет 

выполнено автоматически и в строке геометрической модели 

(Geometry) появится зелѐная галочка, означающая завершенное 

состояние элемента (рис. 14). При в строке сетки (Mesh) отображаются 

зелѐные стрелочки, что означает, что входная информация данного 

блока изменилась и требуется обновление. Чтобы открыть 

сеткогенератор, достаточно дважды щѐлкнуть левой кнопкой мыши 

по данному пункту. При этом произойдет автоматическая загрузка в 

сеткогенератор рассматриваемой геометрической модели. 
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Создание сеточной модели 

 
Рис. 14 - Состояние проекта при возвращения в окно Workbench 

 

Окно сеткогенератора (рис. 15) состоит из графической части, 

где можно видеть автоматически импортированную модель тройника, 

дерева проекта, окна визуализации, а также других элементов, 

аналогичных элементам Design Modeler. 

 

 
Рис. 15 - Окно сеткогенератора Meshing с моделью тройника 
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Перед непосредственно генерацией сетки необходимо 

пометить грани геометрической модели соответствующие разным 

параметрам потока, для того чтобы в дальнейшем на них можно было 

задавать разные граничные условия. 

 

Шаг 1. Помечаем торец короткой части толстой трубы смесителя. Для 

этого в графическом окне выбираем левой кнопкой мыши этот торец. 

Выделенный элемент приобретет зелѐный цвет. Далее нужно 

нажатием правой кнопки мыши на свободном поле графического окна 

вызвать контекстное меню (рис. 16) и выбрать в нѐм пункт Create 

Named Selection (создать наименованную группу). 

 

  
Рис. 15 - Окно сеткогенератора Meshing с моделью тройника 

 

В появившемся окне Selection Name (название группы) нужно 

ввести название границы Inlet1. Название не должно содержать 

пробелов, может включать латинские буквы, цифры, знаки «-» и «_» и 

должно начинаться с буквы. После подтверждения ввода (нажатия 

кнопки OK), в дереве проекта появится группа Named Selections 

(наименования), содержащая только что созданный элемент inlet1 

(рис. 16). 
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Рис. 16 - Наименованная граница inlet1 в дереве проекта 

 

Шаг 2. Аналогичным образом необходимо подписать границы inlet2 - 

для торца тонкой трубы и outlet - для второго торца толстой трубы 

(рис. 17) и symmetry - для плоскости симметрии. Чтобы развернуть 

модель, используйте среднюю кнопку (колѐсико) мыши. 

 

 
Рис. 17 - Все наименованные границы 

 

Шаг 3. После создания наименований необходимо задать параметры 

сетки и построить еѐ. Для этого выбираем в дереве проекта пункт 

Mesh (сетка) и в окне детализации включаем опцию загущения сетка в 
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пристеночном слое (Inflation). Для этого нужно раскрыть (нажать «+») 

список Inflation (рис. 18) и задать опцию «управление алгоритмом»: 

 

Use Automatic Inflation -> Program Controlled 

 

Размеры элементов сетки (Sizing) оставим по умолчанию. Для 

построения сетки нужно правой кнопкой мыши вызвать контекстное 

меню и выбрать пункт Update или Generate Mesh (рис. 19). Можно 

также использовать аналогичные кнопки на панели инструментов. 

Через какое-то время генерация сетки (рис. 20) закончится, и 

если в дереве проекта выделить элемент Mesh, можно будет видеть 

расчѐтную сетку (рис. 21). Индикатор состояния сетки при этом 

примет вид зелѐной галочки. 

 

 
Рис. 18 - Задание параметров 

сетки 

 
Рис. 19 - Запуск сеткогенерации 

 

 
Рис. 20 - Процесс сеткогенерации 
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Рис. 21 - Построенная сетка с загущенным пристеночным слоем 

 

После этого сеткогенератор (Meshing) можно закрыть и 

вернуться в Workbench. Сохранение сетки при этом произойдѐт 

автоматически. На этом этапе можно сохранить расчѐтный проект, 

нажав в окне Workbench (рис. 22) кнопку  или . 

Название необходимо давать латинскими буквами и желательно 

сохранять проект по возможности ближе к корневом каталогу диска. 

Например, на диске «D» создать каталог «<номер группы>CFD<номер 

погруппы>» и в него сохранить проект под именем «Lab1»: 

D:\2305CFD1\lab1.wbpj 

После сохранения можно включить опцию 

View -> Files 

и просмотреть в появившейся таблице список файлов, относящихся к 

проекту (см. рис. 22). Это файл геометрии с расширением agdb и сетки 

- mshdb. В этой же таблице указано расположение этих файлов. 

 

Можно видеть, что статус расчѐтной сетки проекта 

«выполнено» ( ). А строка описания расчѐтной задачи (Setup) готова 

к обновлению ( ). Чтобы перейти в пре-процессор, дважды щелкните 

на элементе Setup. При этом появится окно загрузки программы Fluent 

(рис. 23). В нѐм можно оставить все параметры по умолчанию и 

нажать OK для запуска Fluent. 
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Рис. 22 - Окно Workbench с сохраненным проектом 

 
Рис. 23 - Окно загрузки Fluent 

 

Постановка расчѐтной модели и еѐ решение 

Окно Fluent (рис. 24) состоит из графического окна, в котором 

можно видеть загруженную модель, окна текстовых сообщений, в 

которое выводятся результаты выполнения команд, дерева проекта и 

панели инструментов. В зависимости от того, какой пункт выбран в 

дереве проекта, открывается соответствующая панель. На панели 

General (общее) собраны инструменты для начальной настройки 

задачи. 
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Рис. 24 - Окно Fluent 

 

Шаг 1. Перед началом расчѐта необходимо проверить сетку на 

наличие ошибок, нажав на панели General кнопку Check (проверка). 

При этом будет выполнена проверка, заключающаяся в определении 

габаритов сетки, минимальных и максимальных объѐмов расчѐтных 

ячеек и площадей их граней (рис. 25). Если в сетке присутствуют 

ошибки, будут выведены соответствующие сообщения. Если ошибок 

нет, сообщение будет выглядеть, как показано на рис. 25. 

 

 
Рис. 25 - Результат выполнения команды Check 
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Шаг 2. Необходимо выставить единицы измерения длины - дюймы, 

чтобы в дальнейшем было удобнее задавать гидравлический диаметр 

каналов. Для этого нужно нажать кнопку Units и в появившемся окне 

(рис. 26) выбрать в левом списке элемент Length (длина), а в правом 

списке - in (дюймы). По окончании задания единиц, нужно закрыть 

окно, нажав Close. 

 

 
Рис. 26 - Задание дюймов в качестве единиц измерения длины 

 

Шаг 3. Задаѐм условия моделирования. Необходимо задать учѐт 

энергии, поскольку потоки, смешиваемые в тройнике, имеют разную 

температуру, и включить моделирование турбулентности, поскольку 

смешиваемые потоки будут формировать турбулентные пульсации 

скорости. Для этого в дереве проекта переходим на вкладку Models 

(модели) (рис. 27). 

 

Шаг 4. Задаѐм моделирование энергетических потоков. Для этого 

нужно дважды щѐлкнуть по пункту Energy (энергия), в появившемся 

окне (рис. 28) поставить галочку Energy Equation (уравнение энергии) 

и закрыть окно (нажать OK). 

 

Шаг 5. Задаѐм моделирование турбулентности по модели k-ε. Для 

этого нужно дважды щѐлкнуть по пункту Viscous (вязкость), в 

появившемся окне (рис. 29) выбрать модель турбулентности k-epsilon 

(2 eqn) и закрыть окно (нажать OK). 
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Рис. 27 - Вкладка Models 

 
Рис. 28 - Включение в 

расчѐт уравнения энергии 

 

 
Рис. 29 - Включение в расчѐт 

двух уравнений модели 

турбулентности k-ε 

 
Рис. 30 - Вкладка Materials 

 

 

Шаг 6. Добавляем в проект расчѐта новое вещество - воду. 

Для этого нужно перейти на вкладку Materials (вещества). 

Можно видеть (рис. 30), что по умолчанию в проекте доступны два 

вещества: воздух (air) в качестве текучей среды (fluid) и алюминий 

(aluminum) в качестве сплошной (solid). 
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Для добавления или изменения свойств веществ нужно нажать 

кнопку Create/Edit (создать/изменить). В появившемся окне свойств 

(рис. 31) нужно ввести данные для воды: 

Name (имя) -> water  

Density (плотность) -> 1000 kg/m3 

Cp (Specific Heat) (теплоѐмкость) -> 4200 J/kg-K 

Thermal Conductivity (теплопроводсть) -> 0.6 W/m-K 

Viscosity (вязкость) -> 0.001 kg/m-s 

Внимание! Во Fluent в отличие от Design Modeler и 

Meshing разделителем целой и дробной части чисел 

является точка, а не запятая.  

 

 
Рис. 31 - Задание параметров воды 

 

По окончании задания свойств, необходимо нажать кнопку 

Change/Create (изменить/создать), и на вопрос Change/Create mixture 

and Overwrite air? (изменить/создать смесь и перезаписать воздух?) 

ответить Yes (да). При отрицательном ответе воздух будет сохранен, а 

вода будет добавлена в список как отдельное вещество. После 

выполнения изменения свойств можно закрыть окно (Close). 
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Шаг 7. Задаѐм граничные условия. Для этого нужно перейти на 

вкладку Boundary Conditions (граничные условия) (рис. 32).  

 

Выбрать в списке граничных условий inlet1, проверить, что 

типом данного граничного условия является velocity-inlet (вход с 

заданием скорости потока), нажать кнопку Edit и в появившемся окне 

(рис. 33) и задать следующие параметры: 
Вкладка Momentum (количество движения): 

Velocity Magnitude (величина скорости) -> 2 m/s 

Turbulence (турбулентность): 

Specification Method -> Intensity and Hydraulic Diameter 

(метод задания -> интенсивность и гидравлический диаметр) 

Turbulent Intensity (интенсивность турбулентности ) -> 5% 

Hydraulic Diameter (гидравлический диаметр) -> 4 in 

Вкладка Thermal (тепло): 

Temperature (температура) -> 297 k 

 

Аналогичным образом поочередно нужно задать параметры 

всех граничных условий: 
inlet2: 

Type -> velocity-inlet 

Momentum: 

Velocity Magnitude (величина скорости) -> 0.4 m/s 

Turbulence: 

Specification Method -> Intensity and Hydraulic Diameter 

Turbulent Intensity -> 5% 

Hydraulic Diameter -> 0.8 in 

Thermal: 

Temperature -> 363 k 

 

outlet: 

Type -> pressure-outlet (выход с заданием давления) 

Momentum: 

Gauge Pressure (статическое избыточное давление) -> 0 

Turbulence: 

Specification Method -> Intensity and Hydraulic Diameter 

Backflow Turbulent Intensity -> 5% 

Backflow Hydraulic Diameter -> 4 in 

Thermal: 

Backflow Temperature -> 310 k 

 

symmetry 

Type -> symmetry 



 27 

 
Рис. 32 - Вкладка Boundary 

Conditions 

 
Рис. 33 - Окно задания граничного 

условия inlet1 

Давление во Fluent задаѐтся от уровня опорного или 

ссылочного давления (Operating Pressure), которое по умолчанию 

установлено равным 1 атм. 

 

Шаг 8. Проводим инициализацию задачи - заполнение расчѐтной 

модели первичными значениями - начальными условиями. Для этого 

нужно перейти на вкладку Solution Initialization (инициализация 

решения), на панели выбрать смешанный тип инициализации (рис. 34) 

- Hybrid Initialization и нажать кнопку Initialize. При этом в ходе 

десяти итераций будут вычислены предварительные значения, и ими 

будет заполнена расчѐтная область. При этом в текстовом окне будет 

выведена надпись «hybrid initialization is done»  

Шаг 9. Выполняем решение. Для этого нужно перейти на вкладку Run 

Calculation, ввести в поле Number of Iterations (количество итераций) 

некоторое количество итераций, например 100 и нажать кнопку 

Calculate (вычислять). При этом начнѐтся процесс поиска решения 

(рис. 35). При поиске решения в графическом окне отображается 

график так называемых невязок (Residuals) по количеству решаемых 

уравнений, а в текстовом окне выводится таблица изменения невязок 

от итерации к итерации. Когда будет завершено требуемое количество 

итераций или на какой-то итерации все невязки окажутся меньше 

установленного по умолчанию значения (0.001), решение считается 

сошедшимся (Solution is converged) и расчѐт заканчивается с 

появлением окна сообщения (рис. 36), в котором нужно нажать OK. 
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Рис. 34 - Окно задания граничного 

условия inlet1 

 

 
Рис. 36 - Окно сообщения 

«Расчѐт завершѐн» 

 

 

Шаг 10. Просмотрим результаты расчѐта. Для этого нужно перейти на 

вкладку Graphics and Animations (графика и анимация) (рис. 37).  

 
Рис. 35 - Вкладка Run Calculation и процесс поиска решения 
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Рис. 37 - Вкладка Graphics and 

Animations 

  
Рис. 38 - Задание параметров 

визуализатора Contours 

Дважды щелкнув на элементе Contours (контуры), задаѐм 

параметры визуализации (рис. 38): 

Options -> Filled (залитые поля контуров) 

Surfaces -> symmetry (поверхности окрашивания), 

и нажимаем Display. При это в графическом окне отобразится поле 

распределения статического давления на плоскости симметрии 

(рис. 39). Аналогичным образом можно просмотреть поля скорости, и 

температуры (рис. 40), если в поле Contours of (контуры чего?) задать 

Velocity и Temperature соответственно, каждый раз нажимая кнопку 

Display. 

 

Рис. 39 - Поле распределения статического давления 
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Рис. 40 - Поля распределения скорости и температуры 
 

После этого можно выйти из Fluent, закрыв его, и вернуться в 

WorkBench. Сохранение модели и результатов как обычно произойдѐт 

автоматически. Проект теперь содержит выполненные этапы 

постановки задачи (Setup) и еѐ решения (Solution). Анализ результатов 

будет произведен несколько позднее. 

Модификация расчѐтной модели 

 

Шаг 1. Создание копии проекта. Для этого нужно, нажав правой 

кнопкой мыши первую строчку проекта (на синюю «шапку»), вызвать 

контекстное меню и в нѐм выбрать пункт Duplicate (дублировать). 

При этом произойдѐт копирование проекта (рис. 41). 

  

Рис. 41 - Дублирование проекта WorkBench 
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Шаг 2. Изменение диаметра тонкой трубы. В скопированном проекте 

дважды щелкаем элемент Geometry и открываем Design Modeler (рис. 

42). В дереве проекта выделяем элемент Cylinder3, находим в окне 

детализации значение радиуса цилиндра и меняем его с 0,8 дюйма на 

1,2 дюйма (рис. 42). Чтобы изменения вступили в силу, нужно 

произвести обновление проекта нажатием кнопки . После 

этого можно закрыть Design Modeler и вернуться в WorkBench. 

 

Шаг 3. Обновление сетки. Поскольку геометрическая модель была 

изменена, необходимо заново выполнить построение сетки. Однако 

теперь не требуется повторное задание параметров, поскольку все 

параметры сетки были скопированы из старого проекта. Всѐ, что 

нужно выполнить - это вызвать контекстное меню и выполнить 

обновление (Update) сетки (рис. 43). Через какое-то время сетка будет 

перестроена и примет статус «выполнено». 

 
Рис. 42 - Изменение диаметра тонкой трубы 
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Рис. 43 - Обновление сетки 

 

Шаг 4. Также обновления требует Setup. Однако, для 

выполнения правильного расчѐта, необходимо изменить 

гидравлический диаметр входа inlet2 в соответствии с новым 

диаметром трубы. Поэтому заходим во Fluent, дважды щѐлкнув на 

элементе Setup. При этом на появившийся вопрос (рис. 44) 

«Вышестоящая сетка данного элемента была изменена. Хотите 

загрузить новую сетку?» нужно ответить «Да». 
 

 
Рис. 44 - Окно сообщения 

 

При этом будет открыт Fluent и в него будет загружена новая 

сетка. Нужно перейти на вкладку Boundary Conditions и открыв (Edit) 

описание границы inlet2, установить новое значение гидравлического 

диаметра (рис. 45). 

 

Шаг 5. Далее необходимо произвести инициализацию нового расчѐта 

(Solution Initialization -> Initialize) и выполнить повторный расчѐт (Run 

Calculation -> Calculate). Убедившись, что расчѐт сошѐлся (Solution is 

converged), можно закрыть Fluent и вернуться в WorkBench. 
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Рис. 45 - Обновление параметров границы inlet2 

Анализ полученных результатов 

Шаг 1. Чтобы сравнить результаты двух расчѐтов, желательно 

производить анализ результатов в одном блоке. Для этого нужно 

найти в WorkBench в списке компонентов Results (результаты) и 

поместить его на поле проекта двойным щелчком (рис. 46). 

 

Далее нужно «подключить» результаты расчѐтов к этому 

блоку. Для этого нужно «схватить» элемент Solution первого расчѐта, 

перенести его на элемент Results и «отпустить». При этом будет 

установлена связь (рис. 47). 

 

 
Рис. 46 - Компонент Results на 

поле проекта 

 

 
Рис. 47 - Компонент Results, 

связанный с одним расчѐтом 
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Затем аналогичным образом нужно установить вторую связь (рис. 48). 

 

 
Рис. 48 - Компонент Results, связанный с двумя расчѐтами 

 

Шаг 2. Необходимо выполнить анализ результатов. Для этого нужно 

зайти в пост-процессор, дважды кликнув на элементе Results. При 

этом откроется окно пост-процессора и в него загрузятся результаты 

обоих расчѐтов (рис. 49). 

 
Рис. 49 - Окно пост-процессора с двумя расчѐтными моделями 

 

Шаг 3. Нужно добавить в пост-процессор визуализатор «контур», 

вызвав из главного меню:: 

Insert -> . 
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В появившемся окне (рис. 50) можно оставить название по 

умолчанию, нажав OK. 

Далее в окне детализации нужно установить следующие 

параметры (рис. 51): 

Location (размещение) -> symmetry  

Variable (переменная) -> Static Temperature 

и нажать Apply (применить). Развернув модели нужным образом, 

можно получить картину, удобную для сравнения (рис. 52) 

 

Также можно получить картины распределения скорости 

(Velocity), давления (Static Pressure) и других параметров. 

 

 

 
Рис. 50 - Окно задания названия 

визуализатора 

 

 
Рис. 53 - Окно задания названия 

визуализатора 

 

 
 

Рис. 51 - Окно детализации 

Contour 1 

 

Шаг 4. Создаѐм линию для построения графика. Для этого в главном 

меню выбираем пункт: 

Insert -> Location -> Line 

и соглашаемся с именем по умолчанию, нажав OK (рис. 53) 
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В окне детализации линии устанавливаем параметры (рис. 54): 

Point 1 ->  0 0 0.001 

Point 2 ->  -0.3 0 0.001 

Line Type -> Cut 

и нажимаем Apply. 

 

 
Рис. 52 - Сравнение результатов расчѐта двух конструкций 

 
Рис. 54 - Добавление линии Line 1 
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Шаг 5. Добавляем график: 

Insert ->  

Устанавливаем его параметры в окне детализации на 

нескольких вкладках: 

Data Series: 

 Location -> Line 1 

X Axis: 

 Variable -> X 

Y Axis: 

 Variable -> Velocity 

И нажимаем Apply. При этом отрисовывается график скорости 

вдоль оси X на линии Line 1 (рис. 55). Также могут быть получены 

графики других параметров, если в поле Variable на вкладке Y Axis 

задавать Static Pressure, Static Temperature и т.п. 

 

 
Рис. 55 - Добавление линии Line 1 

 

После просмотра результатов можно закрыть пост-процессор, 

и сохранить проект Workbench. 
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Преподавателю 

Лабораторная работа, выполняемая по данным методическим 

указаниям является первой в цикле «CAE-системы в МЖГ», 

рассчитана на 4 часа и предполагается следующий порядок 

выполнения работы: 

1. Преподавателем выполняется краткая лекция по CFD в 

форме медиа-презентации: введение в CFD, потребность в сетке, 

необходимость качественных сеток; источники погрешностей CFD-

расчѐта, непрямые CFD-расчѐты (моделирование турбулентности, 

химической кинетики, многофазности) - 1,5 часа; 

2. Под руководством преподавателя или по метод. указаниям 

студенты знакомятся с ANSYS Workbench и выполняют второй 

пример из справки Fluent, описанный в данном метод. пособии и 

состоящий двух этапов расчѐта Г-образного патрубка и сравнения 

полученных результатов течений с построением графика скоростей и 

температур, анализ результатов - 2,5 часа. 

Самостоятельная работа студентов на данной лабораторной 

работе не предусмотрена. 

 


